MJERENJE TEMPERATURE | VLAZNOSTI | NJIHOVO
PRIKAZIVANJE NA WEB STRANICI

Kusevié, Kristijan

Undergraduate thesis / Zavrsni rad
2024

Degree Grantor / Ustanova koja je dodijelila akademski / strucni stupanj: Karlovac
University of Applied Sciences / VeleuciliSte u Karlovcu

Permanent link / Trajna poveznica: https://urn.nsk.hr/urn:nbn:hr:128:543709

Rights / Prava: In copyright /Zasti¢eno autorskim pravom.

Download date / Datum preuzimanja: 2024-08-27

Repository / Repozitorij:

( , VELEUCI_LISTE U KI_-\RLQVCU
Karlovac University of Applied Sciences Repository Of Karlovac University Of Applled

D

Sciences - Institutional Repository

AN §epér

rd i r.ns k. h r DIGITALNI AKADEMSKI ARHIVI I REPOZITORLI


https://urn.nsk.hr/urn:nbn:hr:128:543709
http://rightsstatements.org/vocab/InC/1.0/
http://rightsstatements.org/vocab/InC/1.0/
https://repozitorij.vuka.hr
https://repozitorij.vuka.hr
https://zir.nsk.hr/islandora/object/vuka:3058
https://dabar.srce.hr/islandora/object/vuka:3058

VELEUCILISTE U KARLOVCU
STROJARSKI ODJEL
PRIJEDIPLOMSKI STRUCNI STUDIJ MEHATRONIKE

KRISTIJAN KUSEVIC

‘MJERENJE TEMPERATURE |
VLAZNOSTI | NJIHOVO PRIKAZIVANJE
NA WEB STRANICI

ZAVRSNI RAD

KARLOVAC, 2024



VELEUCILISTE U KARLOVCU
STROJARSKI ODJEL
PRIJEDIPLOMSKI STRUCNI STUDIJ MEHATRONIKE

KRISTIJAN KUSEVIC

‘MJERENJE TEMPERATURE |
VLAZNOSTI | NJIHOVO PRIKAZIVANJE
NA WEB STRANICI

ZAVRSNI RAD

mr. sc. Vedran Vyroubal, v. pred.

KARLOVAC, 2024



IZJAVA

Izjavljuiem da sam samostalno radio ovaj zavrsni rad. Ovaj rad sam napravio sa steCenim

znanjima tijekom obrazovanja i koriStenjem strane i domace literature.

Ovom prilikom bih se htio zahvaliti svim svojim ¢lanovima obitelji, prijateljima i kolegama koji

su mi davali podrsku kroz cijeli studij.

Takoder se zahvaljuiem mentoru Vedranu Vyroubalu na steCenome znanju i mentorstvu

ovoga zavrsnoga rada.

Karlovac, 2024. godina Kristijan KuSevic




SAZETAK

Glavna tema ovoga zavrSnoga rada je pokazati kako preko senzora za mjerenje temperature
i vlaznosti, mikrokontrolera i web servera se moze posti¢i mjerenje temperature i vlage i
prikazivanje mjerenja preko grafova prikazani na web stranici. Ovaj rad je savrSen primjer
kako se moze nadzirati temperatura i vlaga Zeljenog prostora bilo gdje na svijetu koristeci

web stranicu na kojoj ¢e se vrijednosti prikazivati u stvarnome vremenu.

KLJUCNE RIJECI
Temperatura, vlaga, ESP32, Web-server, DHT11

SUMMARY

The main topic of this undergraduate thesis is to show how temperature and humidity
measurement can be achieved through sensors for measuring temperature and humidity,
microcontrollers and web servers and displaying the measurements via the graphs displayed
on the website. This work is a perfect example of how one can monitor the temperature and
humidity of a desired space anywhere in the world using a website where the values will be

displayed in real time.
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1. UvVvOD

Temperaturu i vlaznost zraka uoCavamo svaki dan. Znatno utjeCu u oblikovanju
klimatskih promjena, ekosustava i ljudskog zdravlja. Ljudska bic¢a su jako osjetljiva na
vlaznost zraka i temperaturu i zbog tog razloga je jako bitno nadgledati te dvije fizikalne
veliine.
Temperatura predstavlja mjeru kineti¢ke energije Cestica u zraku u odredenome prostoru.
Promjene temperature utjeCu na gustoCu zraka i formiranje atmosferskoga tlaka. Kroz
promjene u temperaturi mozemo bolje razumijeti utjecaj na poljoprivredu, ekonomsku

aktivnost i energetsku potroSnju. Najvise koristene mjerne jedinice za temperaturu su:
°C(stupanj Celzijev), F(Fahrenheit) i K(Kelvin).

Vlaznost zraka se odnosi na prisutnost vodene pare u atmosferi. Igra kljuénu ulogu u
formiranju oblaka i padalina. Analiza vlaznosti zraka pomaze u razumijevanju stvaranja
oblaka te time i formacija padalina ¢ime se mogu predvidjeti mogucnosti oborina,

vlaznosti tla i pratecih ekoloSkih promjena.

U kontekstu zavrSnog zadatka, glavni cilj je demonstrirati kako sustavno pratiti promjene
u stvarnom vremenu, koriste¢i mikrokontroler i senzor kako bismo dublje razumijeli
dinamiku temperature i vlaznosti zraka. Za potrebe ovog zavrSnog rada je odabran
mikrokontroler ESP32 zbog mogucénosti povezivanja s internetom preko WI-FI-a na kojem
Ce biti spojen senzor temperature i vlage pod imenom DHT11. Sva mjerenja koja senzor
prikuplja ¢e biti spremljena u bazu podataka radi pohrane. Analizirat ¢e se koriStenje
“endpointa” koji ¢e web stranici prosljedivati mjerenja iz baze podataka i time ih prikazivati

u obliku zasebnih grafova za temperaturu i vlagu.



2. ESP32

ESP32 je niz mikrokontrolera tvrtke Espressif, razli€itih sposobnosti i performansi.

Stekao je popularnost sa svojim specifikacijama kao Sto su:

e Mala cijena

¢ Niska snaga

e Wi-Fi moguc¢nosti

e Bluetooth

e Bogato periferno ulazno/izlazno sucelje

e Kompatibilan s Arduino “programskim jezikom”

ESP32 predstavlja vrlo mo¢an mikrokontroler koji je postao klju¢an dio u podrucju “loT”
(Internet of Things). Kombinira visokoperformansno obradu podataka s integriranim
Bluetooth i Wi-Fi funkcionalnostima koji inZenjerima i programerima pruza Siroki spektar

za razvijanje projekata.

ESP32-ova kljuCna karakteristika je njegova dvostruka jezgra arhitektura koja je
omogucila jo§ brzu i efikasniju obradu zadataka od njegovog prethodnika ESP8266.
Pored tog, dolazi s razliCitim perifernim uredajima kao $to su analogni-digitalni
pretvornik(ADC), digitalne ulazno izlazne pinove, 12C, SPI i UART komunikacijske
mogucénosti Sto daje korisnicima Sirok opseg opcija povezivanja razliCitih senzora,
aktuatora i ostalih uredaja. Wi-Fi i Bluetooth komunikacije omogucuju bezi¢no
povezivanje $to je daje mogucnost daljinskog upravljanja i komunikaciju s drugim

uredajima na mrezi.

Slika 1. ESP32 Chip



2.1 Razvojne plo¢e ESP32

NajCeSce kada se pri¢a o ESP32, pri¢a se o razvojnoj ploci na koju je ESP32 spojen.

Koristenje samog “chipa” nije jednostavno niti prakti¢no, pogotovo pri u¢enju i testiranju.
Razvojne ploCe se sastoje od svih potrebnih dijelova za napajanje i kontroliranje “chipa”.

Najbitnije znaCajke razvojne ploce su:

e USB-to-UART sucelje i krug regulatora napona — Sucelje je bitno jer mu je
svrha da spoji ESP32 s raCunalom kako bi se programski kod mogao prenijeti.

e BOOT i RESET/EN gumb: Funkcija im je za resetiranje ploCe i stavljanje ploCe u
“flashing” modu rada u kojemu se kod prenesi na plocu.

e Broj pinova i konfiguracija pinova — Svaki pin ima svoju svrhu ovisno kako je
postavljen nacin rada u programskome kodu, stoga treba paziti kako se spaja.

e Prikljuéak za antenu — Vecina razvojnih ploa dolazi s ve¢ ugradenom Wi-Fl
antenom. Neke ploce imaju priklju€ak za vanjsku Wi-Fi antenu.

e Prikljuc¢ak za bateriju — Neke razvojne ploCe imaju priklju¢ak za spajanje LiPo
baterija, ali veCina ploa se napajaju preko USB-B konektora koji se napajaju
preko racunala ili preko izvora poput “POWERBANK?” ili direktno spojen preko

adaptera na uti¢nicu.[1]

Slika 2. ESP32 razvojna plo¢a



Za potrebe ovog rada odabrana je NodeMCU ESP32 razvojna plo¢a od Joy-It kompanije.
Ova razvojna ploCa je jednostavna za programiranje putem Arduino integriranog

razvojnog okruzenja. Specifikacije ove razvojne ploCe su:

e 2,4 GHz dual mode Wi-Fi i Bluetooth bezi¢na veza.
e 512 kB SRAM i 4 MB memorije

e 2x DAC (Digital to Analog Converter)

e 15x ADC (Analog to Digital Converter)

e 1xSPI (Serial Peripheral Interface)

e 1xI2C (Inter-Integrated Circuit)

e 2x UART (Universal Asynchronous Receiver/Transmitter)

PWM (Pulse Width Modulation) se aktivira na svim digitalnim pinovima. Pregled pinova

se moze vidjeti na sljedecoj slici:

(e I_I Is)
RESET—{ EN |+@ — ‘ ‘ {03 | fvspi-mos]
[ e ) o{022 } facsa]
[(W]re {10 |
Dia}-te o R0 |
DIs|—-8 *{ D021 fizcsoa]
TOUCHS [EF = ] & D15 [vsri-misc]
L. FERNNENNEEN & D18 | vsPi-sck]
d o{o5 | frseiss]
[AcE ooz o {7z ]
R & RxZ
[CEPiCix}—{roucHs |—abcig—{Dia}+# & 04 |—{apcio—froucHo]
[P-mso}—ToucHs —aocis—{oiz}+# & 02 |hocia—froucHl)
|5PI-MOSI—TOUCH4 —ADC 14 B & 015 |—ADC13—{TOUCH3}—{5PI-55|
GO} & GnD
Vinl-+e {33V
O Q)

Slika 3. Polozaj pinova na ESP32 razvojnoj plodi



3. DHT11 SENZOR

DHT11 je digitalni senzor za mjerenje temperature i vlage koji se najceSce koristi u
svrhe “loT” (Internet of Things). Senzor omogucuje mjerenje temperature u rasponu od
0 do 50 stupnjeva Celzijusa s to€nosSc¢u od 2 stupnja Celzijusa, dok vlaznost mjeri u
rasponu od 20 % do 90 % s to€noS¢u od +5 %. Senzor se sastoji od 3 pina: VCC
(napajanje), GND (zemlja) i S pin koji je odgovoran za dvosmjernu komunikaciju izmedu
senzora i mikrokontrolera. Komunikacija se odvija u obliku digitalnih impulsa gdje senzor

Salje niz bitova koji predstavljaju podatke o temperaturi i vlaznosti.

Tip DHT11 senzora koji je koristen u ovome zavrSnome radu je model VMA311 od
proizvodaca VELLEMAN. Specifikacije ovoga senzora su prikazani na tablici 1.1, a izgled

senzora je prikazan na slici 3.

Napon 5VvDC
Raspon temperature 0-50°C | gresSka +/- 2°C
Vlaznost 20-90 % | greska +/- 5%
Tip izlaznog signala Digitalni
Dimenzije 39 x 23 x 10 mm
Maksimalna struja 2.5mA

Tablica 1: Karakteristike DHT11 senzora

4

Slika 4. Senzor za mjerenje temperature i vlage DHT11



3.1 Nac¢in rada DHT11 senzora

Za mjerenje temperature u njemu se nalazi NTC (negativni temperaturni koeficijent)
termistor. Termistor je elektronicka komponenta €iji otpor ovisi o temperaturi. U ovome

slucaju se koristi termistor NTC tipa koji pri porastu temperature njegov otpor pada.

Senzor generira elektricne impulse koji prolaze kroz termistor, a mjerenje promjene
otpornosti omogucuje senzoru da ocCita temperaturu. To analogno ocCitanje zatim se
pretvara u digitalni format kako bi se lakSe prenio mikrokontroleru putem digitalne

komunikacije.

Za mijerenje vlaznosti, DHT11 senzor sadrzi u sebi kapacitivni senzor vlaznosti. On se
sastoji od kondenzatorskog elemenata koji u sebi ima dvije elektrode s dielektricnim
elementom koji sadrzava vlagu izmedu njih. Kada zrak u okolini postane vlazniji tada taj
dielektricni materijal apsorbira vlagu i time mijenja kapacitet kondenzatora. Senzor

generira promijenjeni kapacitivni signal koji je proporcionalan vlaznosti zraka.

Integrirani krug (IC) u senzoru obraduje ovaj signal i pretvara ga u digitalni format. Ova
digitalna vrijednost vlaznosti zajedno s digitalnim podacima o temperaturi zatim se Salje

mikrokontroleru putem digitalne komunikacije. [2]

Humidity Sensing
Component

NTC Temeperature Sensor
Thermistor

Slika 5. Konstrukcija DHT11 senzora



4. SPOJ ESP32 RAZVOJNE PLOCE | DHT11 SENZORA

Pravilno povezivanje komponenata klju¢no je za uspjeSno funkcioniranje sustava.
Spoj je vidljiv na slici 6. i izveden je tako da je + pin DHT11 senzora spojen na napajanje
VCC Ciji je izlazni napon 5 V na kojem DHT11 zahtijeva za inicijalizaciju. Ako se VCC
spoji na 3.3 V senzor nece raditi. — pin senzora je spojen na uzemljenje (GND) ESP32

mikrokontrolera dok je signalni pin (S) spojen na D13 pin ESP32-a.
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Slika 6. Shema ESP32 mikrokontrolera i DHT11 senzora



4.1 Arduino Integrirano Razvojno Okruzenje (IDE)

Samim spajanjem senzora s razvojnom plo¢icom nece aktivirati senzor i samim time
prikupljati podatke o temperaturi i viaznosti zraka. Prvo trebamo programirati razvojnu
ploCu, a to se izvodi preko ARDUINO IDE-a. ESP32 nema svoje razvojno okruzenje ali
je kompatibilno s ARDUINO IDE-em.

U praksi, velik broj programera Koristi integrirano razvojno okruzenje (IDE) prilagodeno
Arduino platformi, koje je dostupno za razliCite operacijske sustave. Korisnici mogu pisati
kod za Arduino u programskom jeziku C/C++. IDE pruza osnovne znacajke poput
oznaCavanja sintakse, automatskog dovrSavanja i prikaza greSaka radi lakSeg

programiranja.

Arduino IDE sadrzi mnoge ugradene primjere i biblioteke koje olak8avaju pocetnicima u
razvoju. Ovo omogucava brzi poCetak rada s osnovnim projektima. IDE automatski
kompilira Arduino kdd u strojni jezik koji je razumljiv mikrokontroleru. Takoder omogucava
prenosSenje programa na Arduino plo¢u putem USB veze. Arduino IDE ima ugradeni
monitor serije koji omogucava pracenje izlaznih podataka iz Arduino mikrokontrolera. To
je korisno za dijagnostiku i provjeru ispravnosti rada programa. Na njemu ¢emo dobivati

podatke od senzora za stanje temperature i vlaznosti zraka.

Arduino IDE je “open-source” softver, $to znaci da je dostupan za besplatno preuzimanje
i prilagodbu prema potrebama korisnika. Velika zajednica korisnika i razvijatelja pridonosi

stalnom poboljSavanju i dodavanju novih znacajki. [3]



4.2 Inicijalizacija ESP32 s Arduino IDE

Spajanjem ESP32 razvojne ploCe s raCunalom neée odmah omoguditi da se kod
napisan u Arduino IDE-u prenese na razvojnu plo¢u. Kako bi to omogudili treba prvo u
postavkama Arduino IDE-a postaviti 2 “linka” u polje za plo€e koje nisu Arduino. Postupak
je da se klikne na “File” > “Preferences”. Tada u polju "Additional Boards Manager URLS"
se zalijepe 2 “linka” kao na slici 7. Ta 2 “linka” predstavljaju adrese mreznog resursa koji
se koristi u Arduino IDE za pristup informacijama o dodatnom paketu potrebnom za

podrsku ESP32 mikrokontrolera.

Preferences

Settings

Additional Boards Manager URLs
Enter additional URLs, one for each row

hittps://dl espressif com/dl/package esp32_index json

https:/fraw githubusercontent com/espressiffarduino-esp32/gh-pages/package_esp32_index json

Click for a list of unofficial board support URLs

CANCEL

( canceL )

Slika 7. Dodavanje podr8ke za ESP32 razvojne plocCe

Iduci korak je instalirati biblioteku koja daje podrSku za sve vrste ESP32 razvojnih ploca.
Postupak je da se klikne pod “Tools” > “Board” > “Board Manager’. U polje za
pretrazivanje se upiSe “esp32” i odabere se paket od “Espressif Systems” i odabere se

“install” kao na slici 8.



BOARDS MANAGER

Esp32

Type: |[Al v|

Arduino ESP32 Boards by

Boards included in this package: Arduino Nano
ESP32

|E_U_13 V|

esp32 by Esj

Boards included in this package: ESP32 Dev Board,
ESP32-52 Dev Board, ESP32-53 Dev Board, ESP32-
3 Dev Board, Arduino Nano ESP32

|2_EI.14 v|

Slika 8. Odabir paketa za ESP32 razvojnu plocu

Iz padajuceg izbornika odabirom opcije “Tools” > “Board” pojavljuje se “esp32” izbornik u
kojemu biramo odgovarajuéu razvojnu plo€u. U kontekstu ovoga zavrSnoga rada to je
“‘ESP32 Dev Module”. Finalni korak je kada je ESP32 razvojna ploa spojena s
raCunalom da se odabere “PORT” preko kojega raCunalo komunicira s razvojnom

plocom. Sada je razvojna plo€a spremna za programiranje. [4]
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5. Programiranje ESP32 razvojne ploc¢e

Za ispravan nacin DHT11 senzora potrebno je instalirati potrebne pakete. Postupak
je da iz padajuceg izbornika odaberemo “Tools” > “Manage libraries” i u polje za

pretraZivanje potraze iduca 2 paketa:

e “DHT sensor library by Adafruit”

e “Adafruit Unified Sensor”

Program za mjerenje temperature i vlaznosti zraka prikazan je kodom:

#include <DHT.h>
DHT dht(12, DHT11);

float temp;
float humidity;

void setup() {

dht.begin();
delay(2000);

Serial.begin(115200);
Serial.println();

}

void loop() {

temp = dht.readTemperature();
humidity = dht.readHumidity();
Serial.print("Temperatura: ");
Serial.print(temp);
Serial.print(" Vlaga: ");
Serial.print(humidity);
Serial.println();

delay(5000);

11



Koristenjem ugradenog “Serial Monitora” u Arduinu, moze se vidjeti u stvarnome

vremenu Sto senzor mjeri kao Sto je prikazano na slici 9.

e mem o S _— - - e o e —
ld1dei13]l.4£49 > lempe Z3.10 Vliaga: 23 i
1212241 38.26 —» Temperatura: Z4.00 20 .30
12:22:42]1.2595 ->» Temperatura: Z4.00 20.10
1992« 45 275 Tamnerats > A s g -
1212241482759 ->» Temperatura: Z4.00 49 i
192759 2AE Tamrerati11Ta 7 A s 5N
ldrdeial.3 2o -» lemperatura Z2.00 Vliaga: 2U.0U
12:22:158.329 —>» Temperatura: Z£49.10 20 .30
12:23:01.372 —->» Temperatura: Z4.10 20.30
19 =949 116 T amme r et > A s 5O B0
12:23:08.416 —-> Temperatura A% . LU oLl . Bl
O —- - - e o -
ldrdaill. alb - le Z2.10 Vliaga: 2U.Z3U
P e — - o m wre o -
474 — = 4 J1la0:s
1 walhod s LD . > Te i AU ¥Vidg4. o1l.4U
T 18 9 Ta . 10 WVl as 5 5
12:243:21.488 -> Te Z24.10 Vliaga: 20.30
e TTD o T C T o —~ A OTTT = e = Crh o
12143140 .5011 > Te A2.a0 Viaga: aU.oU
- - - —- —a m Trm o -
ld143:31l.2032 —» le 2.0 Vliaga: 2U.ZU
P P — - - AT e [
q C - = 4 3 J1la0:s :
1 wadod o 30 w20 > Te i U Widga. oU.UU
P e - a A T = e -
14:2453:41.2582 -> Te Z4.20 Wlags

Slika 9. Prikazivanje mjerenja temperature i vlaznosti zraka

Vremensko kasnjenje od najmanje 2 sekundi je preporu¢eno za preciznije mjerenje, ali
tu je postavljeno 5 sekundi jer ¢e mjereni podaci kasnije biti poslani prema bazi podataka
i radi stabilnosti je uzeto duze vrijeme. Takoder pri inicijalizaciji senzora je dobro uzeti 2-
3 sekunde vremenskog kasnjenja kako bi se mogao izvrsiti interni postupak koji ukljuuje
kalibraciju i stabilizaciju senzora. Ako se ne postavi vremensko kasnjenje pri inicijalizaciji
dolazi do neto¢nih rezultata mjerenja ili senzor uopce tada ne mjeri. Svaki model DHT11

ima razliCite periode inicijalizacije.
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6. MYSQL baza podataka

Ve¢ smo u stanju napraviti web stranicu, ali ona bi samo pokazivala trenutne
vrijednosti temperature i vlage i brisala bi stare vrijednosti jer ih ne bi mogla nigdje
spremati. Zbog toga nam je potrebna baza podataka. Za svrhe ovog zavrSnog rada je
odabrana MYSQL baza podataka

MySQL predstavlja besplatan i otvoren izvor sistema za upravljanje bazama podataka,
pruzajuci ucinkovito skladistenje, upravljanje i pristup podacima. Nastao je kao rezultat
rada struCnjaka u industriji i stekao je Siroku popularnost zbog svoje otvorene prirode i
snaznih znacajki. Centralna karakteristika MySQL-a lezi u organizaciji podataka u

tablicama te sposobnosti medusobnog povezivanja tih tablica.

MySQL je Siroko prihvac¢en u razli€itim industrijama, ukljuujuci web razvoj, e-trgovinu i
sustave za upravljanje sadrzajem. U pogledu sigurnosti, MySQL implementira razne
mehanizme kao Sto su autentikacija, autorizacija i enkripcija kako bi zastitio podatke.
Takoder, pruza alate i postupke za administraciju baze podataka, olakSavajuci

upravljanje kompleksnim sustavima.

MYSQL se pokrece preko web servera $to znaci da se pristupa preko web preglednika.
To je najlakSa varijanta za koristiti tu bazu, ali se takoder moze pristupiti uz MYSQL
Workbench alata ili komandne linije. Za pokretanje web servera se koristi Apache.
Njegova glavna funkcija je upravljanje HTTP zahtjevima, obradivanje dinamickih

sadrzaja, i slanje stati¢kih ili dinamicki generiranih stranica korisnicima. [5]

Postoji program koji nam omogucuje paljenje ta 2 servisa vrlo jednostavno. XAMPP je
distribucija softvera koja ukljuCuje Apache web server, MySQL bazu podataka, PHP i
druge komponente, pruzajuci potpuno okruzenje za razvoj i testiranje web aplikacija na
lokalnom racunalu. Pri pokretanju XAMPPa i odabirom opcije za pokretanje Apache
servera i MySQL baze podataka, oba servisa se pokreéu zbog potreba razvojnog

okruzenja.

13



XAMPP se moze preuzeti s njihove sluzbene stranice i moguce ga je instalirati na

Windows/Linux/Mac platformama.[6] SuCelje XAMPPa izgleda kao na slici 10.

KAMPP Control Panel v3.3.0 [ Compiled: Apr 6th 2021 ]

XAMPP Control Panel v3.3.0
Modules
Service  Module PID{s) Port(s) Actions
Apach 17744 :
pache 4408 80, 443 Stop Admin Config
MySQL 1928 3306 Admin Config
FileZilla Start Admin Config
Mercury Start Admin Config
Tomcat Start Admin Config
NERCEENELT apout running tnis applicaton Witn aaminisirator rngnis!
1:13:16 PM [main] ¥AMPP Installation Directory: "c-\wxamppt”
1:13:16 PM [main] Checking for prerequisites
121317 PM [main] All prerequisites found
1:13:17 PM [main] Initializing Modules
1:13:17 PM [main] Starting Check-Timer
1:13:17 PM [main] Control Panel Ready
1:13:23 PV [Apache]  Attempting to start Apache app...
1:13:23 PM [Apache]  Status change detected: running
1:13:25 PM [mysql] Attempting to start MySQL app...

Slika 10. Sucelje XAMPP programa

Kako bi pristupili bazi, u web pregledniku je potrebno upisati idudi link:

e http://localhost/phpmyadmin/

Logs
Logs
Logs
Logs

Logs

O x
-,ﬁ: Config

4 Netstat

Bl shel

Explorer
= .
L SEervices
& Help

[F aui

Izgled stranice s vec¢ postojeéim razliitim bazama podatak izgleda kao na slici 11.
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http://localhost/phpmyadmin/

php! B 17 Server 127001 =|
aNeT@e Databases | SQL § Status = Useraccounts =} Eaport (o} impot J* Setiings || Replication ¢ Variables = Charsets |4 Emgines g Plugins
0 (g
Recent Favorites
=™ Seneral settings L
% New
#+-J informatian_schema = Server connaction collaion’ @ utfmbd_unicade ci - * Server: 127.0.0.1 via TCPIP
®-5 mysql » Server iaDB
i * More settings
*#- performance_schema - * Server n. SSLis not being used g
- X
#+ | phpmyadmin = Server version: 10.4.32-MariaDB - mariadb.org binary distribution
i
#-4 test » Protocol version: 10
» User: root@locathost
~ Server charset: UTF-3 Unicode (utfBmbs)
& Language @ English ~
@Theme | pmahomme v | Viewall
« Apache/2.4 58 (Win64) OpenSSL/3.1.3 PHP/B212
» Database client version: Ebmysql - mysqind 8.212
+ PHP extension: mysql g curl g mbstring
« PHP version 8212
 Version information: § 2.1 {up to datz)
= Documentation
| Homepage
Licens
= Console

Slika 11. Prikaz web stranice za pristupanje MYSQL bazama podataka.

U lijevom izborniku nalazi se opcija za stvaranje novih baza podataka. Pri stvaranju nove
baze potrebno je navesti ime baze, broj redova, nazive redova, te njihov tip. U ovome
slu€aju ime tablice ¢e biti “Zavrdni_rad”, a broj redova ¢e biti 4. Razlog zasto 4 je taj jer

¢e nam trebati ID reda, zasebni redovi temperature i vlage i red kada je podatak izmjeren.

Prikaz toga je prikazan na slici 12.

M Cfiserver 127.00.1 > @ Database: zavisni rad

4 Structure | [] SQL 4 Search (i) Query &} Export [& Import 4” Operations =9 Privileges 4% Routines () Events 35 Triggers ® Tracking &5 Designer & Central columns

Piok from Central Columns,

Table name: | Zavi&ni rad Add |1 column(s)( Go
Structure @)
Name Type © Length/Values @ Default & Collation Attributes Null Index A_l Comments Virtuality Move column
D PRIMARY v
BIGINT - None ~ ~ ~ O y ~
Pick from Central Columns. PRIMARY
humidity
Fiok from Central Columns
temperature
date
TIMESTAMP CURRENT_TIME ~ v v vl O -
Fiok from Central Columns
>
Table comments: Collation: Storage Engine: @
- InnoDB v

PARTITION definition: &

Partition by | (|Expression or columnlist |}
Partitions

Preview SQL Save

Slika 12. Prikaz stvaranja tablica u bazi podataka
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7. Spremanje mjerenja u bazu podataka

Svako mjerenje koje senzor izmjeri treba odmah spremiti u bazu podataka. Potrebno
je prvo locirati instalaciju XAMPP paketa, pronaci mapu pod imenom “htdocs”, te u njoj
napraviti novu datoteku s bilo kojim imenom. U njoj ¢e biti spremljena PHP skripta koja

se koristi za povezivanje s MYSQL bazom. [7]

<?php

class dht11{

public $link="";

function _ construct($temperature, $humidity){
$this->connect();
$this->storeInDB($temperature, $humidity);

}

function connect(){

$this->1link = mysqli_connect('localhost', 'root',"'') or die('Cannot connect to
the DB');

mysqli select db($this->1ink, 'zavrsni_rad') or die('Cannot select the DB');

}

function storeInDB($temperature, $humidity){

$query = "insert into zavrdni rad set humidity='".$humidity."',
temperature="".$temperature.""'";
$result = mysqli_query($this->1link,$query) or die('Errant query: '.$query);
}
}
if($_GET['temperature'] != "' and $_GET['humidity'] != ""){
$dhtll=new dht11($_GET[ 'temperature'],$ GET['humidity']);
}
?>

Za svako spremanje mjerenja, skripta mora dobiti ovakav oblik zahtjeva:

¢ http://localhost/testcode/dht.php?temperature=[mjerenje]&humidity=[mjerenje]
Naprimjer kada ruéno u web pregledniku se upise:

e http://localhost/testcode/dht.php?temperature=20&humidity=68

u bazi podataka ¢e se spremiti da je temperatura bila 20 °C, a vlaznost 68 %
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— [ — = |D temperature humidity date
[0 47 Edit % Copy @ Delete 1 20 68 2024-03-06 15:26:54

Slika 13. Ru¢no spremanje podataka u bazu

Takav princip da se preko HTTP zahtjeva spremaju podaci se mogu ostvariti tako da se
u programskome kodu za ESP32 nakon svakoga mjerenja temperature i vlaznosti zraka

poSalje HTTP zahtjev i spremi podatke u bazu. Novi kod za ESP32:

#include <DHT.h>
#include <WiFiClient.h>
#include <WiFi.h>

DHT dht(12, DHT11);

float temp;
float humidity;

const char* ssid = "Ime mreze";
const char* password = "Sifra_mreze";
char server[] = "IP_mreze";

WiFiClient client;
void setup() {

dht.begin();
delay(2000);

Serial.begin(115200);

Serial.println();
Serial.println();
Serial.print("Connecting to ");
Serial.println(ssid);

WiFi.begin(ssid, password);

while (WiFi.status() != WL_CONNECTED) {
delay(500);
Serial.print(".");
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}
Serial.println("");

Serial.println("WiFi connected");

Serial.println("Server started");
Serial.print(WiFi.localIP());
delay(1000);
Serial.println("connecting...");

void loop() {
// put your main code here, to run repeatedly:
temp = dht.readTemperature();
humidity = dht.readHumidity();
Sending_To_phpmyadmindatabase();
delay(5000);

void Sending To_phpmyadmindatabase() {
if (client.connect(server, 80)) {
Serial.println("connected");

// Send HTTP GET request

client.print("GET /testcode/dht.php?humidity=");
client.print(humidity);
client.print("&temperature=");
client.print(temp);

client.println(" HTTP/1.1");
client.println("Host: IP_mreze");
client.println("Connection: close");
client.println();

Serial.print("GET /testcode/dht.php?humidity=");
Serial.print(humidity);
Serial.print("&temperature=");
Serial.println(temp);

}

else {
Serial.println("connection failed");
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Na slici 14 je prikazano kako se Salje HTTP zahtjev, a na slici 15 je prikaz spremanja

mjerenja.

10:08:57.282 -> GET /testcode/dht.php?humidity=54.50&temperature=23.60
10:09:02:325 —=> connected
10:09:02.325 -> GET /testcode/dht.php?humidity=56.90&temperature=23.70
10:09:07.353 -> connected
10:09:07.353 -> GET /testcode/dht.php?humidity=56.806&temperature=23.80
10:09:12.427 -> connected
10:09:12.427 -> GET /testcode/dht.php?humidity=55.906&temperature=23.80
10:09:17.441 -> connected
10:09:17.483 -> GET /testcode/dht.php?humidity=55.106&temperature=23.80
10:09:22.503 -> connected

Slika 14. HTTP zahtjevi za spremanje podataka

— T — + |ID temperature humidity date

[] g7 Edit FCopy @ Delete 14 237 51.2 2024-03-06 15:49:23
[] 7 Edit ¥%cCopy @ Delete 15 237 51.7 2024-03-06 15:49:28
[0 g7 Edit F£Copy @ Delete 16 237 51.6 2024-03-06 15:49:33
[] g7 Edit %cCopy @ Delete 17 237 512 2024-03-06 15:49:38
[0 g7 Edit %&£ Copy @ Delete 18 237 51.3 2024-03-06 15:49:43
[] &7 Edit FCopy @ Delete 19 237 51.4 2024-03-06 15:49:43
[0 47 Edit ¥cCopy @ Delete 20 244 53.7 2024-03-06 15:49:53
[ g7 Edit %z Copy @ Delete 21 253 54.8 2024-03-06 15:49:58
[J g7 Edit %cCopy @ Delete 22 26.1 555 2024-03-06 15:50:03
[1 g7 Edit %:Copy @ Delete 23 2689 546 2024-03-06 15:50:03
[] 47 Edit ¥cCopy @ Delete 24 278 53.6 2024-03-06 15:50:13
[0 g7 Edit %cCopy @ Delete 25 283 51.2 2024-03-06 15:50:13
[0 47 Edit F£Copy @ Delete 26 28.1 447 2024-03-06 15:50:24
[] &7 Edit %cCopy @ Delete 27 236 545 2024-03-12 10:08:57
[0 g7 Edit %&Copy @ Delete 28 241 53.2 2024-03-1210:11:29
[] 47 Edit ¥%cCopy @ Delete 29 24 53 2024-03-12 10:11:33
[0 g7 Edit Fc Copy @ Delete 30 241 53.2 2024-03-12 10:11:38
[0 47 Edit %z Copy @ Delete 31 24 53 2024-03-12 10:11:43
] g7 Edit %cCopy @ Delete 32 24 532 2024-03-12 10:11:48
[] g7 Edit % Copy @ Delete 33 24 53 2024-03-12 10:11:53
[] 47 Edit ¥%cCopy @ Delete 34 241 53 2024-03-12 10:11:58

Slika 15. Spremljena mjerenja temperature i vlaznosti zraka
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8. DJANGO Framework

Za web stranice sluzit ¢emo se Djangom. Django je visokokvalitetni web “framework”

napisan u programskom jeziku Python, koji omogucava brzo i efikasno razvijanje sigurnih

I skalabilnih web aplikacija. Razvijen je s fokusom na jednostavnost, ponovnu upotrebu

koda i ubrzanje procesa razvoja. Ovaj “framework” je otvorenog koda, Sto znaci da je

dostupan Sirokoj zajednici programera i omogucava suradnju na poboljSanjima i

ispravkama.[8]

Primarni cilj Djanga je olakSati stvaranje slozenih web stranica vodenih bazama

podataka. Okvir naglaS8ava mogucénost ponovne upotrebe i "priklju€ivosti" komponenti,

manje koda, nisko povezivanje, brzi razvoj i nacelo “ne ponavljaj se”. Python se Koristi

posvuda, ¢ak i za postavke, datoteke i modele podataka.

Glavne osobine Django “frameworka”:

ORM (Object-Relational Mapping): Django pruza ORM sistem koji omogucava
mapiranje objekata u bazi podataka, Cime se smanjuje potreba za pisanjem SQL
upita. Ovo olakS8ava rad s bazom podataka i Cini aplikaciju neovisnom o
odredenom sustavu upravljanja bazom podataka.

Administracijsko sucelje: Django dolazi s ugradenim administracijskim suceljem
koje omogucava jednostavno upravljanje podacima u bazi, bez potrebe za
pisanjem posebnog koda. Ovo je korisno za administratore sustava ili razvojne
timove koji zele brzo pregledati i urediti podatke.

URL rute i pogledi: Django koristi jasan sustav za definiranje URL ruta i
povezivanje s odgovarajué¢im pogledima (“views”). Ovo omogucava organizaciju
ruta u aplikaciji i odvajanje logickih dijelova koda.

Sigurnost: Django ukljuCuje niz sigurnosnih mehanizama ugradenih u
“framework”, ukljuCujuéi zastitu od CSRF (“Cross-site request forgery”) napada,

SQL injekcija i drugih sigurnosnih prijetniji.
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8.1 Stvaranje virtualnog okruzenja

U praksi je najbolje svaki novi Django projekt stvarati u takozvanim virtualnim
okruzenjima. Virtualno okruzenje (eng. virtual environment) je praksa izoliranja Python
okoline za svaki projekt, Cime se osigurava da projekt ima svoje nezavisne biblioteke i
zavisnosti. Biblioteke i zavisnosti Ce biti samo povezane za taj odredeni projekt, nece biti

globalno povezane s ostalim projektima na racunalu.

Primjena virtualnog okruzenja za Django projekte pomaZe u odrzavanju CistocCe i
organizacije projekta, smanjuje konflikte izmedu razliCitih projekata te olakSava

upravljanje zavisnostima i reprodukciju okoline.

Prvo Sto je potrebno napraviti je stvoriti mapu na radnoj povrsini s bilo kojim imenom. U
ovome slu€aju to ¢e biti “Zavrsni rad”. Nakon toga je potrebno otvoriti naredbeni redak
(command prompt — cmd) i u njemu dodi do lokacije te mape. Postupak je prikazan na
slici 16.

| CAWindows\system32\cmd.e: X + -

i C:\Users\kristijan>cd Desktop/Zavrini rad

C:\Users\kristijan\Desktop\Zavrini rad>|

Slika 16. Usmjeravanje u novo kreiranu mapu “Zavrsni rad”.
Nakon pristupanja mapi preko naredbenog retka potrebno je upisati idu¢u komandu:
e python -m venv venv

Ova komanda stvara virtualno okruzenje i u nju ¢e se spremati sve biblioteke koje ¢e se

instalirati za ovaj zavrsni rad.
IDE u kojemu je pisan kod za Django projekt je PyCharm, tvrtke JetBrains.

U PyCharm okruzZenju je potrebno locirati virtualno okruzenje kako instalacija potrebnih

biblioteka ne bi dosla u konflikt s bibliotekama koje su instalirane globalno za cijeli sustav.
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Postupak je sljedeci:

U donjem desnome kutu treba stisnuti na verziju Pythona koju koristimo i dobiti ¢emo

izbornik. U njemu treba stisnuti “Add new interpreter” i u iduéem izborniku odabrati “Add

local Interpreter” kao na slici 17.

Potrebno je odabrati opciju "existing" i kao na slici 18. pronadi datoteku “Scripts” u venv

datoteci i stisnuti na “python.exe”.

# Add Local Interpreter...

¢ Python 3.1
Add Mew Interpreter

Interpreter Se

calt JetBrains'

Zavréni rad\wenv\Scripts\python.exe

Slika 18. Dodavanije virtualnog okruzenja u Pycharmu
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8.2 Instalacija i postavljanje Django frameworka

Sama instalacija Django “frameworka” je vrlo jednostavna. Svodi se na jednu

komandu liniju koju je potrebno upisati u terminal od PyCharm. Postupak je na slici 19.

Slika 19. Instalacija Django frameworka.

Nakon instalacije Django sustava, potrebno je stvoriti Django projekt. Postupak je da se

u terminalu upiSe komanda:
e django-admin startproject Mjerenje

To ¢e stvoriti mapu s potrebnim datotekama za rad Djanga. Zadnji korak je stvoriti
takozvanu “aplikaciju” u kojoj ¢e web stranica raditi. Prvo treba u terminalu otvoriti novu
mapu koja je bila stvorena pri stvaranju projekta, u ovome slucaju to je mapa “Mjerenje”.

Postupak je prikazan s iducom komandom:
e cd Mjerenje

Nakon ulaska u tu mapu, upisuje se idu¢a komanda:
e django-admin startapp MjerenjeApp

Prikaz mapa sa svim potrebnim datotekama je prikazan na slici 20.
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Favrini rad

Mjerenje

Mjerenje

& manage.py
venv

External Libraries

Slika 20. Prikaz mapa Django projekta

Najvedi dio posla ¢e biti u “MjerenjeApp” mapi, dok u “Mjerenje” mapi ¢e se postaviti koju
bazu podataka ¢e Django gledati. Za kraj postavljanja projekta je potrebno instalirati par

Python paketa:

e djangorestframework==3.14.0

e mysqlclient==2.2.1
Nacin instalacije je pip install [ime paketa]

Nakon instalacije u mapi “Mjerenje” u settings.py datoteci je potrebno dodati par

argumenata.

Prvi argument koji se dodaje je naziv imena aplikacije koja je ranije stvorena. To je
“MjerenjeApp” aplikacija. Ona se dodaje kako bi Django inicijalizirao tu aplikaciju, bez
toga ona nece raditi. Dodaje se joS i ime paketa pod nazivom “rest_framework”. On nam
sluzi kasnije za stvaranje takozvanih “endpointa” koji se kasnije koriste za pozivanje
funkcija koje ¢e nam poslati mjerenja iz baze podataka. Nacin na koji se dodaju argumenti

su prikazani na slici 21.
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Slika 21. Dodavanje potrebnih argumenata Django projekta

Za kraj je potrebno povezati MYSQL bazu podataka s Djangom. Postupak je prikazan na
slici 22.

Slika 22. Povezivanje baze podataka s Djangom

Potrebno je paziti na ime baze na koju se veze i da se unesu dobri podaci za

autentikaciju.

Kako bi znali da li sve dobro radi u terminalu moramo biti u “Mjerenje” mapi i potrebno je

upisati idu¢u komandu:

e Python manage.py runserver
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U terminalu Ce se pojaviti adresa na koju pristupamo nasoj web stranici i ako smo sve
dobro napravili na slici 23 je prikaz web stranice na kojoj piSe da je instalacija uspjesno

odradena.

django View release notes for Django 5.0

()

The install worked successfully! Congratulations!

You are seeing this page because DEBUG=True is in your
settings file and you have not configured any URLs.

Slika 23. Prikaz uspjesSno instalirane web stranice

U terminalu se pojavljuje poruka da imamo neodradene migracije. To su zapravo baze
podataka potrebne Djangu za rad. Kako bi rijeSili te migracije potrebno je samo upisati

idu¢u komandu:

e python manage.py migrate
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9. Endpoint

U Django web “frameworku”, "endpoint" se obi¢no odnosi na odredenu URL rutu koja
je definirana u Django projektu. “Endpointi” su povezani s funkcijama ili klasama pogleda
koje obraduju zahtjeve poslane na te rute. To znaci kada budemo pristupali web stranici
u pozadini ¢e se pozvati zahtjevi za dohvacanje mjerenja temperature i vlaznosti zraka

iz baze podataka.

Prvi korak je povezivanje Django modela s bazom podataka. Modeli u Django web
“frameworku” su Python klase koje definiraju strukturu podataka web aplikacije. Ovi
modeli omogucuju interakciju s bazom podataka na nacin koji je jednostavan za

koriStenje i razumijevanje.

Svaki put kada se stvara novi model time se stvara i nova tablica u bazi podataka. U
ovome slu€aju imamo situaciju gdje ve¢ imamo stvorenu tablicu s podacima o mjerenjima
temperature i vlaznosti zraka. Nacin na koji ¢e Django povezati tablicu s modelom se vrsi

idu¢im programskim kodom:

from django.db import models

class Dhtll(models.Model):
id = models.BigAutoField(db_column="ID', primary_key=True)
humidity = models.FloatField(blank=True, null=True)
temperature = models.FloatField(blank=True, null=True)
date = models.DateTimeField()

class Meta:
managed = False
db_table = 'dht’

U modelu potrebno je definirati argumente na isti nacin kao i u bazi podataka. Takoder
tip argumenta mora biti isti. U klasi “Meta” db_table argument spaja model s tablicom pod

imenom “dht”. Nakon svakog stvaranja novoga modela potrebno je izvrSiti migracije.
Postupak je takav da se u terminalu upiSu iduce dvije komande:
e python manage.py makemigrations

e python manage.py migrate
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Prije nego Sto se poc¢nu raditi funkcije za slanje mjerenja web stranici potrebno je te

podatke pretvoriti u odgovarajuéi oblik. Za to nam sluze “serializeri”.

“Serializeri” u Django web “frameworku” sluze za pretvaranje kompleksnih tipova
podataka (poput Django modela) u formate koji su pogodni za prijenos preko mreze, kao
Sto su JSON, XML, ili drugi. Takoder, “serializeri” omogucuju obrnuti proces, tj.

pretvaranje ovih formata nazad u Python objekte.

Glavna svrha “serializera” je olakSati komunikaciju izmedu web aplikacije i klijentskih
aplikacija (npr. JavaScript aplikacija u “Frontendu” ili mobilna aplikacija) putem API-ja

(Application Programming Interface).

Serijalizacija je vrlo jednostavna, potrebno je napraviti novu mapu u “MjerenjaApp” i
nazvati je “serializers” i u njoj napraviti novu Python datoteku pod bilo kojim imenom. U
ovome slu€aju smo je nazvali readings.py. Serijalizacija je prikazana idu¢im programskim

kodom:

from rest framework import serializers
from ..models import Dhtll

class ReadingsSerializer(serializers.ModelSerializer):
class Meta:

model = Dhtl1l
fields = ' all

Takoder u “serializers” mapi je potrebno napraviti __init__.py Python datoteku u kojoj
moramo inicijalizirati sve python datoteke koje se nalaze u toj mapi. Ako se to ne napravi
Python ne¢e moci prepoznati inicijalizaciju tih datoteka u ostalim Python datotekama.

Nacin na koji se inicijalizira readings.py datoteka je:

e from .readings import *

Sada smo spremni za stvaranje funkcija za slanje podataka prema web stranici. Te

funkcije stvaramo u views.py datoteci.
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Stvorit ¢emo jednu funkciju i jednu klasu. U funkciji ¢e biti programski kod za generiranje
web stranice u kojoj ¢e biti definirani koji HTML predlozak Ce se stvarati. U klasi cemo
napraviti HTTP GET funkciju u kojoj ¢emo prikupljati podatke o temperaturi, vlaznosti

zraka, datumu i vremenu mjerenja i ID mjerenja.

from django.shortcuts import render

from .models import Dhtll

from .serializers.readings import ReadingsSerializer
from rest framework.response import Response

from rest_framework import generics, status

from django.http import HttpResponse

# Create your views here.

def Index(request):
return render(request, "index.html')

class Readings(generics.GenericAPIView):

Dohvati sva ocitanja iz baze podataka.
queryset = Dhtll.objects.all()
serializer_class = ReadingsSerializer

def get(self,request):

readings = Dhtll.objects.all()

reading data = []

for reading in readings:

data = {

'id': reading.id,
"temperatura’: reading.temperature,
'Vlaznost': reading.humidity,
'"Timestamp': reading.date

}
reading data.append(data)

return Response(reading_data,status=status.HTTP_200 OK)

Klasa “Readings” predstavlja “endpoint” koji ¢e kasnije biti iskoristen za stvaranje grafova

temperature i vlaznosti zraka.

Nacin na koji ¢e se pozivati je preko URL-a. U “MjerenjeApp” mapi je potrebno napraviti

novu Python datoteku pod imenom urls.py. Ova datoteka obi¢no sadrzi rute koje su
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specificne za funkcionalnosti unutar te aplikacije. Na primjer, imamo aplikaciju za
korisnike, urls.py u toj aplikaciji bi sadrzavao rute za prijavu, registraciju, postavke profila
itd.

Nacin na koji se definiraju rute su prikazane idu¢im programskim kodom:

from django.urls import path
from .views import Readings, Index

urlpatterns = [
path('readings/',Readings.as_view()),

]

Pokretanjem web servera ova ruta nece raditi jer nismo inicijalizirali urls.py iz
“MjerenjeApp” direktorija u projektnom “Mjerenje” direktoriju gdje se isto nalazi pod istim

imenom urls.py datoteka. Nacin inicijalizacije je prikazan idu¢im programskim kodom:

from django.contrib import admin
from django.urls import path, include

urlpatterns = [
path("admin/', admin.site.urls),
path('',include('MjerenjeApp.urls')),

Pristupanju /readings ruti se vrsi tako da se u web pregledniku u polju pretrazivanja za

“‘linkove” upise:

e http://127.0.0.1:8000/readings/

Nakon pristupanja kao na slici 24 dobivamo web stranicu u kojoj ¢e biti prikazan JSON
format podataka mjerenja koji ¢e kasnije biti poslani web stranici na kojoj c¢emo prikazivati

mjerenja preko grafova.
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http://127.0.0.1:8000/readings/

Readings

Readings
Dohvati sva ofitanja iz baze podataka

GET /readings

HTTP 2008 OK

Allow: GET, HEAD, OPTIONS
Content-Type: application/json
Vary: Accept

": 23.7
": 51.6

"2824-83-96T15:49:332"

5:49:382"

OPTI{

Slika 24. Prikaz JSON formata podataka mjerenja

Web stranice se sastoje od 2 strane. “Backend” i “Frontend” strane. Ovo $to smo dosada
napravili je dio “Backend”. “Backend” web stranice u Djangou predstavljaju serversku
stranu aplikacije. To je dio aplikacije koji se nalazi na serveru i koji obraduje zahtjeve
korisnika, komunicira s bazom podataka te Salje odgovore natrag korisnicima. U
“‘Backendu” se stvaraju “endpointi” koji kasnije Salju “Frontend” strani podatke koje

trebamo.
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10.Sucelje web stranice

Sucelje web stranice je ono $to korisnik vidi kada pristupi web stranici. Razvoj tih
sucelja se naziva “Frontend” web stranice.. To je sve ono Sto korisnik vidi i s Cime moze
komunicirati na stranici, ukljuCujuci tekst, slike, forme za unos podataka, tipku za

navigaciju i druge elemente.
Najjednostavnije web stranice se sastoje od 3 glavna elementa “Frontenda”:

e HTML(Hypertext Markup Language) - Osnovni jezik za strukturiranje sadrzaja
web stranica. HTML se Koristi za definiranje strukture i organizacije elemenata na
stranici, kao $to su naslovi, paragrafi, slike, tabele i forme.

e CSS(Cascading Style Sheets) - CSS se koristi za stiliziranje HTML elemenata,
odredujuéi izgled i dizajn web stranice. To ukljuCuje postavljanje boja, fontova,
veliCina i rasporeda elemenata, kao i animacije i prilagodbe za razliite uredaje

e JavaScript - JavaScript je skriptni jezik koji se koristi za dodavanje interaktivnosti
i dinamic¢kog ponasanja na web stranice. S pomocu JavaScript-a mozete dodati
funkcionalnosti poput validacije forme, animacija, interakcije s korisnikom i

dinamiC¢kog aZuriranja sadrzaja bez potrebe za osvjeZavanjem stranice.
Za profesionalnije web stranice se koriste “frameworki” poput Reacta, Angulara, jQuery...
Za potrebe ovoga zavrSnoga rada su dovoljni HTML,CSS i Javascript.

Prvo §to je potrebno napraviti je novu mapu u “MjerenjeApp” i dati joj ime “templates”. U

toj mapi ¢e biti stvorena HTML datoteka u kojoj ¢e biti HTML sucelje web stranice.

Naziv HTML datoteke mora biti index.html zbog toga $to smo u views.py Python datoteci

definirali koji HTML predlozak ¢e se prikazati pri ulasku u web stranicu.

Program za prikaz grafova temperature i viaznosti zraka je prikazan idu¢im kodom:
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<IDOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta http-equiv="X-UA-Compatible" content="IE=edge">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<title>Temperature and Humidity Reading</title>
<!-- Include Chart.js library -->
<script src="https://cdn.jsdelivr.net/npm/chart.js"></script>
</head>
<body>
<h1>Temperature and Humidity Readings</h1>

<l-- Container for the temperature line chart -->
<canvas id="temperatureChart" height="50"></canvas>
<!-- Container for the humidity line chart -->

<canvas id="humidityChart" height="50"></canvas>

<script>
// Inicijaliziranje praznih skupova podataka za temperaturu i vlaZnost
const temperatureData = [];
const humidityData = [];
const timestampData = [];

const temperatureCtx =
document.getElementById('temperatureChart').getContext('2d");
const temperatureChart = new Chart(temperatureCtx, {
type: 'line’,

data: {
labels: [],
datasets: [
{
label: 'Temperature',
borderColor: 'rgb(255, 99, 132)',
data: temperatureData,
bs
1,
bs
options: {
scales: {
x: {
type: 'linear’,
position: 'bottom',
s
y: {

beginAtZero: true,

}s



s
plugins: {
tooltip: {
callbacks: {
label: function (context) {
const labellIndex = context.datalndex;
const timestamp = timestampData[labelIndex];
const temperature = temperatureData[labelIndex];
return ~Temperature:
${temperature}°C\nTimestamp: ${timestamp} ;
}J
}J
}J
s
s
1

const humidityCtx =
document.getElementById( 'humidityChart').getContext('2d");
const humidityChart = new Chart(humidityCtx, {
type: 'line’,

data: {
labels: [],
datasets: [
{
label: 'Humidity',
borderColor: 'rgb(75, 192, 192)',
data: humidityData,
}J
1
s
options: {
scales: {
x: {
type: 'linear’,
position: 'bottom',
}J
y: A
beginAtZero: true,
}J
¥
plugins: {
tooltip: {

callbacks: {
label: function (context) {
const labelIndex = context.datalndex;
const timestamp = timestampData[labelIndex];
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const humidity = humidityData[labelIndex];
return “Humidity: ${humidity}%\nTimestamp:

${timestamp}";

// Po

}J
}J
}J
s
}s
1)

ziv API-a iz backenda za dobitak mjerenja iz baze podataka

function fetchReadings() {

podacima

podacima

fetch('http://127.0.0.1:8000/readings/")
.then(response => response.json())
.then(data => {
updateReadings(data);
}

.catch(error => console.error('Error fetching data:

, error));

function updateReadings(data) {
const timestamps = [];
temperatureData.length = 0;
humidityData.length = 0;
timestampData.length = 0;

data.forEach(reading => {
timestamps.push(reading.id);
temperatureData.push(reading.temperatura);
humidityData.push(reading.Vlaznost);
timestampData.push(reading.Timestamp);

1)

temperatureChart.data.labels = timestamps;
humidityChart.data.labels = timestamps;

temperatureChart.update(); // Azurirajte grafikon temperature novim

humidityChart.update(); // Azurirajte grafikon vlaZnosti novim

}
setInterval(fetchReadings, 56000);

// Pocetno dohvacanje
fetchReadings();

</script>

</body>
</html>
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Zadnji korak u “Backendu” koji se mora postaviti je rutu u urls.py Python datoteci u
“‘MjerenjeApp” mapi. To se mora napraviti tako da kada korisnik pristupi linku web
stranice da se odmah sucelje generira. To se postize idu¢im programskim kodom:

from django.urls import path
from .views import Readings, Index

urlpatterns = [
path('',Index),
path('readings/',Readings.as_view()),

Postavljajuéi senzor blizu radijatora i ostalim dijelovima kuéanstva, nakon odredenog
vremena ovako izgleda web stranica s grafovima temperature i viaznosti zraka kao na
slici 25.

Temperature and Humidity Readings

Slika 25. Prikaz mjerenja temperature i vlaznosti zraka preko grafova

Web stranica se sama osvjezava svakih 5 sekundi kako bi prikupila najnovije podatke iz

baze podataka i prikazivala ih u obliku grafova.
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11.Zakljuéak

Zaklju€ak ovog zavrsnog rada predstavlja integraciju ESP32 mikrokontrolerai DHT11
senzora za precizno mjerenje temperature i vlaznosti zraka. Kroz proces implementacije,
razvijen je sustav koji omogucuje kontinuirano pracenje i prikazivanje ovih mjerenja
putem web sucelja. Koristenje ESP32 omogucéuje pouzdano povezivanje s mrezom, dok

je DHT11 senzor pokazao zadovoljavajucu tocnost u mjerenju temperature i vlaznosti.

Kroz provedene testove, potvrdeno je da sustav pravilno prikazuje stvarne vrijednosti
temperature i vlaznosti zraka. Prikazivanje ovih podataka putem grafova na web stranici
omogucuje korisnicima intuitivno pracenje trendova i analizu promjena u okolini. Osim
toga, implementacija web sucelja omogucuje udaljeni pristup i pracenje podataka putem

interneta, Sto poboljSava prakti¢nost i korisnost sustava.

Ovaj rad predstavlja korak naprijed u koristenju “loT” tehnologija za pracenje okoline.
Buduéi razvoj ovog sustava mogao bi uklju€ivati dodatne senzore ili proSirene
funkcionalnosti, kao $to su upozorenja na ekstremne uvjete ili integracija s drugim “loT”
uredajima. Sveukupno, kombinacija ESP32 mikrokontrolera, DHT11 senzora i web
sucCelja predstavlja mocan alat za pracenje i analizu temperature i vlaznosti zraka u

razliCitim okruZenjima.
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